Daytona Sensors LLC

Engine Controls and Instrumentation Systems

Installation Instructions for
CD-1 Marine Capacitive
Discharge Ignition System

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR SALE
OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES.

OVERVIEW
CD-1 marine capacitive discharge ignition
system P/N 103003 is intended for V8 performance
marine applications. The CD-1 marine system includes
CD-1 marine ignition module P/N 103001 and coil P/N
103002.
 Compatible with 8 cylinder marine engines with
distributor type ignition.
 135 mJ spark energy output.
 Digitally set RPM limit with 100 RPM steps from
3,000 to 9,900 RPM.
 Seven switch selectable advance curves and a fixed
timing mode cover most Mercury marine high
performance applications.
 PC programmable idle stabilization feature.
 PC programmable advance features ranging from a
simple RPM based advance curve to a 3D timing
map with boost proportional retard.
 Built-in data logging capability with 16 Mbit
DataFLASH memory stores up 5 hours of data at 10
samples/second or 30 minutes of data at 100
samples/sec.

 Highly efficient switching power supply based on US
Patents 6518733 and 6636021. Less than 5 amp
current draw at 8,000 RPM.

ADDITIONAL REQUIRED PARTS
To use the PC link or data logging software, you
will require the optional USB interface P/N 102004. To
connect a Delphi MAP sensor, you will have to
fabricate a wiring harness with the appropriate mating
connector or use our MAP sensor harness kit P/N
102006. If your application will trigger the CD-1 direct
from a Mercury Marine Hall effect distributor, you must
use our P/N 103004 marine rotor or modify the existing
rotor using the template in the Appendix.
The parts bag supplied with the CD-1 includes a
signal harness that plugs into the 12 terminal Deutsch
connector, ring tongue terminals for power and ignition
coil connections, and a set of Weather Pack
connectors for tach and PC link hookup. To complete
the installation, some applications may require
additional wire, crimp terminals, fuses, switches, and
relays. The Appendix includes a list of recommended
parts and suppliers.

Figure 1 – CD-1 Marine System

 Dedicated input terminals for manifold pressure and
an externally activated 0-18 degree retard feature.
 Three general purpose input/output terminals. Two
inputs are reserved for data logging. An additional
input/output terminal can be used for data logging or
as an RPM window switch.
 Fully encapsulated construction. 12 pin Deutsch
connector used for signal connections.
 Module and coil are both certified to meet the ignition
protection requirements of the NMMA, the USCG,
ISO 8846 and SAE J1171 standards for marine
applications.
 Compact size. Module is 7.0”L x 5.25”W x 1.9”H. Coil
is 4.4”L x 3.2”W x 3.0”H.
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WIRING OVERVIEW
Power Connections
Heavy (12
AWG) Red

Battery+

Connects to battery positive terminal. Do not connect to the
alternator. If leads must be extended, add filter capacitor as
shown in basic hookup diagrams.

Heavy (12
AWG) Black

Ground

Connects to chassis ground.

Ignition Coil Primary Connections
Orange

Coil+

Connects to coil positive terminal

Black

Coil-

Connects to coil negative terminal

Deutsch Connector Signals
Red (Pin 1)

Ignition
Switch

Connects to ignition switch

Blue (Pin 2)

Retard Input

Connects to external switch to command retard

Orange (Pin 3)

GPI1

General purpose input 1. Used for data logging only

Gray (Pin 4)

GPIO2

General purpose input/output 2

Yellow (Pin 5)

GPIO3

General purpose input/output 3. Used for data logging only

Violet (Pin 6)

Magnetic
Trigger+

Connects to magnetic pickup distributor or crank trigger. If the
magnetic trigger inputs are used, the trigger input on pin 12
must be left open.

Green (Pin 7)

Magnetic
Trigger-

Connects to magnetic pickup distributor or crank trigger. If the
magnetic trigger inputs are used, the trigger input on pin 12
must be left open.

Pin 8

Sensor
Ground

Connects to MAP sensor ground

Pin 9

MAP Sensor

Connects to 0-5V MAP sensor signal

Pin 10

+5V Power

Connects to MAP sensor power

Brown (Pin 11) Tach/RS-232

Connects to tach and optional USB interface

White (Pin 12)

Connects to Mercury Marine Hall effect distributor or trigger
output from engine control module. If this trigger input is used,
the magnetic trigger inputs on pins 6 and 7 must be left open.

Hall
Effect/Module
Trigger
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Figure 2 – Basic Magnetic Trigger Hookup

DISTRIBUTOR
WITH MAGNETIC
PICKUP

CRANK TRIGGER
SYSTEM WITH
MAGNETIC PICKUP

AMP CONNECTORS
CD-1 VIOLET MAG+
CD-1 GREEN MAGREFER TO INSTRUCTIONS
FOR COMMON MAGNETIC
TRIGGER COLOR CODES

VIOLET (PIN 6) AND
GREEN (PIN 7)
TWISTED PAIR
TACH

IGNITION SWITCH
RED (PIN1)

+12V

WEATHER PACK
CONNECTORS
FEMALE
TERMINAL

BROWN
(PIN 11)

MALE
TERMINAL

RPM

TO OPTIONAL USB
INTERFACE USED
FOR PC LINK

BLACK

1

MARINE CD IGNITION

ORANGE

OPTIONAL FILTER CAPACITOR REQUIRED
IF POWER WIRES MUST BE EXTENDED

TO BATTERY+

RED

CD-1 MARINE
IGNITION COIL

BLACK

ENGINE GROUND
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Figure 3 – Basic Mercury Marine Hall Effect Distributor Hookup

OPTIONAL
SHIFT
CUTOUT
SWITCH

MERCURY MARINE
DISTRIBUTOR WITH
HALL EFFECT PICKUP

WARNING: TO AVOID ENGINE DAMAGE
FROM CROSS FIRING, USE DAYTONA
SENSORS P/N 103004 MARINE ROTOR
OR MODIFY MERCURY MARINE ROTOR
P/N 13524T-1 USING TEMPLATE IN
APPENDIX TO CORRECT PHASING.

TACH

WHT/GRN WHITE (PIN 12)

WEATHER PACK
CONNECTORS

GROUND
WHT/RED

BLACK
GROUND

FEMALE
TERMINAL

MALE
TERMINAL

RPM

RED (PIN 1)

+12V
IGNITION SWITCH

BROWN
(PIN 11)

TO OPTIONAL USB
INTERFACE USED
FOR PC LINK

BLACK

1

MARINE CD IGNITION

ORANGE

OPTIONAL FILTER CAPACITOR REQUIRED
IF POWER WIRES MUST BE EXTENDED

TO BATTERY+

RED

CD-1 MARINE
IGNITION COIL

BLACK

ENGINE GROUND
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Figure 4 – Basic Module Trigger Hookup

ENGINE
CONTROL
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TRIGGER
OUTPUT

TACH

WHITE (PIN 12)

WEATHER PACK
CONNECTORS
FEMALE
TERMINAL

MALE
TERMINAL

RPM

IGNITION SWITCH
RED (PIN 1)

+12V

BROWN
(PIN 11)

TO OPTIONAL USB
INTERFACE USED
FOR PC LINK

BLACK

1

MARINE CD IGNITION

ORANGE

OPTIONAL FILTER CAPACITOR REQUIRED
IF POWER WIRES MUST BE EXTENDED

TO BATTERY+

RED

CD-1 MARINE
IGNITION COIL

BLACK

ENGINE GROUND
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INSTALLATION
1. Turn off the ignition and any battery disconnect
switches before proceeding.
2. Select a convenient mounting location in the
engine compartment for the CD-1 module and coil.
Do not mount the module or coil directly on the
engine. We recommend using rubber shock
mounts such as McMaster-Carr
(www.mcmaster.com) P/N 9376K72. Orient the
unit so that you will have easy access to the rotary
switches.
3. Refer to Figures 2-4 for basic hookup. For
corrosion protection in marine environments, apply
Permatex P/N 22058 dielectric grease to all
electrical terminals (not required on the sealed
Deutsch and Weather Pack connectors).

WARNING: Do not cut the power or coil
wires shorter than 12 inches. Doing so
makes the unit impossible to test and
will void the warranty.
4. Power connections. Connect the 12 AWG red
wire to the battery disconnect switch or the battery
cable at the starter solenoid. If the battery is
mounted outside the engine compartment or the
CD-1 red power wire must be extended, a filter
capacitor is required and minimum 12 AWG wire
should be used for the connection. You can use a
10000 UF 25V electrolytic capacitor such as our
P/N 102007 capacitor kit or Mouser
(www.mouser.com) P/N 539-CGS103U025RC3
and bracket P/N 539-VR3A. Ground the 12 AWG
black wire to the engine, preferably where the
battery ground cable is attached. Do not extend
the black ground wire.
5. Ignition switch connection. Connect the red wire
from Deutsch connector pin 1 to the ignition switch
as shown.
6. Trigger signal connections. The violet/green
magnetic pickup cable is supplied with an AMP
connector that will mate with common MSD
magnetic pickup distributors and crank trigger
systems. For other magnetic pickups, cut off the
connector and refer to the color code table below.
For Mercury Marine Hall effect distributors, remove
the Mercury ignition module. Use our P/N 103004
marine rotor or modify the existing rotor using the
template in the Appendix. For module triggered
applications from engine control modules, the CD1 requires a 0-12V square wave signal and fires on

the rising edge. The module trigger input on pin 12
is tolerant of high voltage pulses and has an
internal 680 ohm pull-up resistor to +12V.
Magnetic Trigger Color Codes
System

Mag-

Mag+

Accel/Chrysler
Distributor

Black

Orange/White

Accel Crank
Trigger

Black

White

Moroso Crank
Trigger

White

Black

MSD Crank
Trigger

Green/Black

Violet/Orange

MSD/Ford
Distributor

Violet

Orange

GM Distributor

Green

White

7. Coil connections. Connect the black and orange
coil wires to the ignition coil as shown.

DANGER: High voltage is present at the
coil primary and secondary terminals
whenever the ignition switch is on. Do
not touch or connect any test
equipment to the coil terminals.
8. Tach connection. Use the supplied Weather Pack
connectors as shown to connect the brown wire
from Deutsch connector pin 11 to the tach as
shown. The tach output is also used for PC link
communications before the engine is started by
means of an optional USB interface P/N 102004.
When the engine is running an industry standard
0-12V square wave signal appears on the tach
output with one tach pulse per trigger event. The
rising edge of tach pulse is synchronized with the
trigger event.
9. Application specific signal connections. Refer
to the following sections and Figures 5-9.
10. Completing the installation. Remove any
unused wires from the Deutsch connector and
install supplied terminal seals. Set the CD-1
switches and upload any required setup program.
Start engine and check timing. If timing has
changed significantly, MAG+ and MAG- may be
reversed.
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Figure 5 – MAP Sensor Hookup

DELPHI
MAP
SENSOR

BLACK
A WHITE
B
C RED

PIN
A
B
C

SIGNAL
GROUND
MAP OUTPUT
+5V POWER

10
9
8

RED
WHITE
BLACK

PIN
8
9
10

1

SIGNAL
SENSOR GROUND
MAP INPUT
+5V POWER

MARINE CD IGNITION

Figure 6 – Retard Input Hookup

RETARD
SWITCH
2

1

SWITCHED +12V

BLUE

MARINE CD IGNITION
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Figure 7 – GPI1 Data Logging Hookup Options
0-5V ANALOG SIGNAL OR
0-12V DIGITAL SIGNAL

3

ORANGE

SUPPLIED
1N4007
DIODE

MARINE CD IGNITION

1

SWITCHED +12V

DEVICE
SWITCH

DO NOT INSTALL DIODE WHEN DATA
LOGGING 0-5V ANALOG SIGNALS. FOR
0-12V SIGNALS, THE DIODE IS
REQUIRED IF AN INDUCTIVE DEVICE
SUCH AS A SOLENOID IS PART OF THE
CIRCUIT. WARNING: FAILURE TO
INSTALL REQUIRED DIODE WILL
DAMAGE THE CD-1 MARINE IGNITION
AND VOID THE WARRANTY

Figure 8 – GPIO2 Hookup Options

SUPPLIED
1N4007
DIODE

4

GRAY

DIGITAL DATA
LOG MODE

0-12V DIGITAL SIGNAL

BATTERY+

SWITCHED +12V

OPTIONAL
ARMING
SWITCH

FUSE

85
1

MARINE CD IGNITION

12V
RELAY

RPM WINDOW
SWITCH MODE
86

FOR DIGITAL DATA LOG MODE, THE
DIODE IS REQUIRED IF AN INDUCTIVE
DEVICE SUCH AS A SOLENOID IS PART
OF THE CIRCUIT. WARNING: FAILURE
TO INSTALL REQUIRED DIODE WILL
DAMAGE THE CD-1 MARINE IGNITION
AND VOID THE WARRANTY
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Figure 9 – GPIO3 Data Logging Hookup Options

0-12V DIGITAL SIGNAL

5

YELLOW

SUPPLIED
1N4007
DIODE

1

MARINE CD IGNITION

DEVICE
SWITCH

SWITCHED +12V

THE DIODE IS REQUIRED IF AN
INDUCTIVE DEVICE SUCH AS A
SOLENOID IS PART OF THE CIRCUIT.
WARNING: FAILURE TO INSTALL
REQUIRED DIODE WILL DAMAGE THE
CD-1 MARINE IGNITION AND VOID THE
WARRANTY

MAP Sensor Hookup

GPIO2 Hookup Options

A manifold absolute pressure (MAP) sensor is required
for all applications that use a 3D timing table uploaded
with the PC link.

Figure 8 shows hookup options for GPIO2 modes that
can be programmed by means of the PC link. Refer to
page 19 for programming details.

The optional MAP sensor harness includes mating
connector shells for Delphi 1 bar, 2 bar, and 3 bar MAP
sensors (refer to the Appendix for recommended MAP
sensor part numbers). Select the connector shell with
the appropriate indexing features for your MAP sensor.
Connect the ground, MAP signal, and +5V power wires
as shown in Figure 5.

1. Digital data log mode. This is the default for
GPIO2 if no other mode is programmed. 0-12V
digital off/on values are logged by the CD-1. The
on threshold voltage for digital signals is
approximately 2.5V and the input is tolerant of
voltage levels up to 30V. A switch or relay contact
to +12V can be connected to GPIO2 and logged as
a digital signal.

Retard Input Hookup

2. RPM window switch mode. Connect a relay as
shown to control a load. You can connect an
optional arming switch as shown. For direct battery
power connections, you should also install a fuse.
Refer to the Appendix for recommended relays and
fuses.

Figure 6 shows typical hookup of the external retard
input. The retard feature is activated when the input is
at +12V.

GPI1 Data Logging Hookup Options
Figure 7 shows data logging hookup options for GPI1.
Both 0-5V analog signal levels and 0-12V digital off/on
values are simultaneously logged by the CD-1. The on
threshold voltage for digital signals is approximately
2.5V and the input is tolerant of voltage levels up to
30V. Many sensors have 0-5V signals levels and can
be connected to GPI1. A +5V reference for sensor
power (up to 50 ma current) is available at pin 10. To
avoid errors caused by voltage drop between the CD-1
and engine ground, pin 8 can be used as the sensor
ground. A switch or relay contact to +12V can be
connected to GPI1 and logged as a digital signal.

GPIO3 Data Logging Hookup Options
Figure 9 shows data logging hookup options for
GPIO3. 0-12V digital off/on values are logged by the
CD-1. The on threshold voltage for digital signals is
approximately 2.5V and the input is tolerant of voltage
levels up to 30V. A switch or relay contact to +12V can
be connected to GPIO3 and logged as a digital signal.

WARNING: Failure to install the diodes
shown in Figures 7-9 will damage the
CD-1 and void the warranty.
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Boot load mode (used by factory to
reprogram CD-1 module)

06-99

RPM limit setting X100 (i.e. switch setting 35
= 3,500 RPM)

Fixed timing

1

Mercury HP 425-500 timing curve

2

Mercury HP 525SC timing curve

3

Mercury HP 600SC timing curve

4

Mercury HP 600SC Firepower timing curve

5

Mercury HP 800SC timing curve

6

General purpose timing curve for normally
aspirated engines

7

General purpose timing curve with anti-stall
feature for high performance engines

8-9

Reserved (not used)

901

78

0

456

Timing Curve Switch Settings

RPM LIMIT
X100

23

TIMING
CURVE

MEETS SAE J1171
MARINE REQUIREMENTS

23

RETARD
X2 DEG

23

901

05

23

901

Reserved (not used)

23

901

03-04

Figure 10 – Switches and Status LED

901

RPM limit, multi-spark, and timing functions
disabled

Mode switch setting 1 is used during normal
operation of the CD-1 and allows full functionality of
any selections made with the PC Link software.

78

02

Reserved (not used)

456

RPM limit and multi-spark disabled

2-9

456

01

8 cylinder engine with trigger retard
compensation enabled

456

RPM limit disabled

1

456

00

8 cylinder engine with trigger retard
compensation disabled

78

RPM Limit Switch Settings

0

78

The left end panel of the CD-1 has a status LED
and five rotary switches used to set the RPM limit,
timing curve, external retard value, and operating
mode. The status LED will illuminate when the ignition
switch is turned on. If a fault condition occurs, such as
a DC/DC converter (internal high voltage power supply
used to charge the capacitor) fault or loss of trigger
signal, the status LED will blink.

Mode Switch Settings

78

SWITCH SETTINGS AND STATUS
LED

MODE

STATUS

PN 103001

SPARK PLUGS AND WIRES
To avoid electrical noise that may interfere with
the CD-1 or other onboard computer and radio
equipment, resistor spark plugs are recommended and
spiral core RFI/EMI suppression type spark plug wires
are required. Optimum spark plug gap is .045" for
normally aspirated engines. Engines with high boost
levels may require a smaller spark plug gap. Do not
use solid copper or high resistance carbon core spark
plug wires. Optimum spark plug wire resistance is 50500 ohms per foot, such as Taylor Vertex
(www.taylorvertex.com) ThunderVolt 50 or 8.2mm
spiral core.

Refer to the Appendix for details on the
individual timing curves. Using the PC Link software to
select a 2D or 3D timing table under module
parameters overrides any setting of the timing curve
switch. If you want to use fixed timing or one of the
preset timing curves selected by the switch, click on
the Disable Timing Table option.
Retard Switch Settings
When the retard input is activated by a +12V
signal, ignition timing will be retarded by 2X the switch
value (i.e. switch setting 4 = 8 degrees retard).
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1. Tach hookup. Some original equipment tachs
require a high voltage pulse and will require a
commercially available tach adapter.

2. To avoid electrical noise problems, route magnetic
trigger wiring away from any coil or spark plug
wires. Use only spiral core spark plug wires. Do not
use solid copper core or carbon core resistance
wires.

2. Ignition run-on. If the engine continues to run
after the ignition switch is turned off, current is
leaking back into the CD-1 through the charging
system. Please contact our tech support.

3. Check for broken, loose or corroded connections.
Verify correct air gap for magnetic pickup. Check
distributor for loose, missing, or jammed parts in
advance mechanism.

TROUBLESHOOTING

4. Verify that spark plugs are proper type, gap size,
and heat range.

APPLICATION ISSUES

Did the engine run properly before installation of
the CD-1? If not, remove the CD-1, reinstall the original
ignition system and then find and correct the original
problem. Did the CD-1 function correctly before the
problem occurred? If the answer is yes, did you
change anything that may have affected it? To isolate
the problem, go back to the last setup that was OK. If
the engine will not start, runs intermittently, or misfires,
use the following check list steps:

5. Replace spark plugs, spark plug wires, and
distributor rotor and cap.

Status LED Doesn’t Illuminate
If the status LED doesn't illuminate after the
ignition switch is turned on, check power and ground
connections. Use a volt meter to verify +12V at the
battery+ and ignition switch wires at the CD-1 with the
ignition switch in both the run and start positions. The
CD-1 requires a minimum of +9V when the ignition
switch is first turned on. During cranking, the unit will
continue to operate down to +4.5V.
Engine Will Not Start
If the status LED illuminates when the ignition
switch is turned on but the engine will not start, verify
that the status LED blinks while the engine is cranking.
If the status LED doesn't blink during cranking, the unit
is not getting a trigger signal. Verify that trigger signal
wiring is not shorted together or to ground. If the status
LED blinks, but engine will not start, recheck coil
primary connections or replace coil.
Spark Testing
K-D Tools HEI ignition test plug P/N 2756 is
recommended for spark testing. Attach the alligator clip
on the test plug to chassis ground and fabricate a short
section of spark plug wire to connect the test plug to
the coil.
Intermittent Operation or Misfire at High RPM
1. Misfire at high RPM is usually not an electrical
problem with the CD-1. Common causes include:
coil failure or arcing at spark plug boots or within
the distributor.
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CD-1 SOFTWARE OVERVIEW
The Windows software suite for the CD-1
system consists of the PC Link CD Marine and CD Log
programs. PC Link CD Marine allows you to set
module parameters that control overall operation of the
system and override certain switch settings, program
the functions of the general purpose input/output
(GPIO) terminals, and program advance curves. CD
Log software allows you to download data from the
CD-1 module, open and save files to disk, display data
on a chart, and print chart graphics. Chart display for
downloaded data allows you to monitor operation.
Note that the PC Link CD Marine software is a
special marine version of the standard PC Link CD
software used with the CD-1 automotive ignition. Do
not use the standard PC Link CD software with the CD1 marine ignition. The CD Log software supports both
marine and automotive ignitions.
Use of the software programs is optional and not
required for basic operation of the CD-1 system. If you
are not planning on using the software, you can skip
the rest of the material in this instruction manual.

PC REQUIREMENTS
The CD-1 connects to your PC by means of an
optional USB interface P/N 102004. The PC must have
a free USB port. If you have an older PC without USB
capability, you cannot use the CD-1 software.
We recommend a laptop PC with Pentium
processor and super VGA display (SVGA with 1024 x
768 pixel resolution) running Windows XP/Vista/7.
Data chart display is graphics intensive and a high
speed Pentium processor is recommended.
Processors slower than 300 MHz will exhibit sluggish
program loading and response. The PC must have a
CDROM drive for program loading.
PC Link CD Marine and CD Log software
include print commands to print downloaded data. The
programs have been tested with Hewlett-Packard laser
and inkjet printers and Epson inkjet printers. We
recommend using a color inkjet printer.

USB INSTALLATION
The USB interface for the CD-1 is based on the
FTDI FT232R chip and drivers that allow the unit to
emulate a standard Windows RS-232 COM port.
Updated Windows drivers, installation instructions and
troubleshooting tips are available on the FTDI website
at www.ftdichip.com. Additional information and
troubleshooting tips can be found on the PC Link Tech
FAQ on our website at www.daytona-sensors.com.

A new USB driver that simplifies the installation
process is available. This installs as an executable file,
similar to other Windows programs. The Windows
Found New Hardware Wizard will then detect the USB
device when it is first connected and automatically
install the correct driver without the user having to
browse out to the CDROM.
Before proceeding with installation, shutdown
any other applications that may be running. For
Windows Vista, you must disable the User Account
Control (UAC) during installation. If you are not familiar
with the UAC, please refer to the Vista UAC Tech Note
on our website's PC Link Tech FAQ for details.
1. Make sure your USB interface is not connected to
your PC. Please note that the USB interface does
not need to be connected to the CD-1 during the
USB installation process.
2. Insert the Daytona Sensors CDROM. When the
Daytona Sensors autorun menu appears, click on
Software. Scroll down and click on the USB Driver
link. When the File Download dialog box appears,
click on "Run this program from its current
location." Ignore any security warnings and click on
Yes to continue.
3. After installation of the driver is complete, connect
the USB interface to the PC with the supplied USB
cable. The Windows Found New Hardware Wizard
will appear and complete installation of the USB
interface.

COM Port Configuration
After completing the installation steps outlined
above, you must configure the new COM port using
Device Manager.
1. Windows XP: click Start, Settings, Control Panel,
System, Hardware, and then Device Manager.
Windows Vista: click Start, Control Panel, System
and Maintenance, and then Device Manager.
Windows 7: Click Start, Control Panel, System
and Security, and then Device Manager. For more
information, visit www.pcsupport.about.com.
2. Scroll down to Ports (COM and LPT). The new
USB interface will appear as a USB Serial Port.
Click on this new port. Click on the Port Settings
tab.
3. Click on Advanced. In most cases the wizard will
have installed your new USB interface as COM5.
Note the COM port number assigned for your
system. For optimum performance, you should
also change the BM Options Latency Timer to 2
msec as shown in the Figure 11.
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4. Once you have configured a COM port number for
your new unit, make sure that you use this same
COM port selection in the CD-1 software by using
the Port Setup command from the
Communications menu.

Figure 11 – COM Port Configuration

Once InstallShield has completed the
installation, PC Link CD Marine and CD Log will
appear on the Windows Start Menu. You can then
launch them just as you would any other Windows
program.
The programs require the Monospace 821 BT
fixed pitch printer font in order to properly align
columns when printing. The Monospace 821 BT font is
included in the distribution media and automatically
copied to your Windows Fonts folder during
installation. A backup copy is also placed in the
program folder. If you accidentally delete this font, use
the Install New Font command from the Fonts folder
File menu. The filename associated with Monospace
821 BT is monos.ttf.

PC LINK CD MARINE SOFTWARE

SOFTWARE INSTALLATION
The software is supplied on CDROM media or in
the form of a compressed file downloaded from our
website. The installation process uses InstallShield.
This industry standard installer is based the new
Microsoft Windows Installer service that greatly
reduces potential problems such as version conflicts
and allows for application self-repair.
There are two programs to install: PC Link CD
Marine and CD Log. Start by installing PC Link CD
Marine. If you are downloading software from the web,
only download and install one program at a time. Before
proceeding with installation, shutdown any other
applications that may be running. For Windows Vista,
you must disable the User Account Control (UAC)
during installation. If you are not familiar with the UAC,
please refer to the Vista UAC Tech Note on our
website's Tech FAQ for details.
Use the Windows Explorer or the Run command
from the Windows Start Menu to launch setup.exe in the
PC_Link_CD_Marine folder on the CDROM or the
setup.exe file downloaded from our website. InstallShield
will install the software in an appropriate folder under
Program Files.
Repeat the installation process for CD Log. Use
the Windows Explorer or the Run command from the
Windows Start Menu to launch setup.exe in the CD_Log
folder on the CDROM or the setup.exe file downloaded
from our website. InstallShield will install the software in
an appropriate folder under Program Files.

The brown tachometer wire (Deutsch connector
pin 11) from the CD-1 is used connect to the USB
interface. Mating single pin Packard Weather Pack
connectors are supplied with the CD-1 to facilitate
disconnecting the brown wire from the tachometer and
connecting it to the USB interface as shown in Figures
1-3. PC communications is possible when the ignition
is turned on and the engine has not yet been started.
Once the engine is started, the brown wire resumes its
normal function of driving the tachometer. Note that no
damage occurs if the engine is inadvertently started
while the USB interface is connected.
After PC Link CD Marine is launched, the main
screen appears blank. You have three options for
obtaining setup data for editing. You can open a
previously saved setup file by using the Open Table
command on the File menu. You can create a new
setup file by using (as applicable) the Edit Module
Parameters and Edit Idle Stabilization and GPIO
Parameters commands from the Edit menu and the
New Timing Table command on the File menu. You
can also download data from an attached CD-1 module
by using the Download From EEPROM command on
the Communications menu.
Note that setup files use a .tbl extension. You
should create a separate folder to store these files.
If you have enabled a 2D or 3D timing table
under module parameters, you can use the Edit Timing
Table command from the Edit menu. You can edit the
timing table data by clicking on and dragging individual
points on the chart display or you can directly edit
numeric data on the spreadsheet grid.
Once the appropriate parameters and timing
table data have been entered, you can print the data
using the Print Parameters and Timing Table
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command on the Print Menu. You can save the edited
setup file by using the Save Table command on the
File menu.
You can upload the setup data to an attached
CD-1 module by using the Upload to EEPROM
command on the Communications menu.
A setup file (CD1_Marine_Sample.tbl) is
included in the program folder.

DOWNLOADING DATA FROM
EEPROM
Connect the USB interface. An adapter harness
is supplied with the USB interface. Connect the
alligator clip on the black wire to ground and the
Packard Weather Pack connector to the brown tach
wire from the CD-1 wire harness. If the tach wire is not
equipped with a Weather Pack connector, you can use
the supplied brown jumper wire with an alligator clip to
make the required connection. Set the switch on the
USB interface to the "A" position. Turn the ignition
switch on to provide power to the CD-1. Do not start
the engine.
When launched for the first time, the program
uses COM1 as the default port. In most cases, you will
have configured the USB interface to use a different
COM port, such as COM5. Use the Port Setup
command on the Communications menu to select the

correct COM port. The program will remember the new
port setup.
Download data by using the Download From
EEPROM command on the Communications menu.
If the download process is successful, the
module parameters are displayed. You can then edit
setup data as explained in subsequent sections.
CD-1 units are shipped from the factory with
default parameters and timing tables loaded into
EEPROM memory. If you have never uploaded any
custom setup file to EEPROM memory, these defaults
are what you will see.

MODULE PARAMETERS
Module parameters are displayed in a dialog box
by using the Edit Module Parameters command on the
Edit menu. Module parameters control the overall
operation of the CD-1 unit.
When PC Link CD Marine is first started, default
module parameters are loaded. Module parameters
are updated whenever you download data from a CD-1
unit or open a setup file. Module parameters are saved
along with the GPIO parameters and timing table data
when you save a setup file. Always check the
module parameters before uploading data to the
CD-1.

Figure 12 – Module Parameters
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General Options

use the 3D timing table, a MAP sensor must be
connected. Refer to Figure 5 and page 9 for details.

Disable RPM Limit - all RPM limit functions are
disabled (including any fixed maximum RPM limit
selection).

Trigger Timing

Disable Multi-Spark - multi-spark is disabled. Multispark should always be disabled when an external
engine control that generates the trigger signal for the
CD-1 also limits RPM. Missing trigger pulses could
cause false multi-spark and result in cross-firing within
the distributor.
Disable Timing Functions - all timing functions
including the automatic start retard and any timing
table are disabled.
Fixed Maximum RPM Limit - selecting this option
overrides the RPM limit value set on the switches and
the RPM limit slider is displayed.
Automatic Start Retard - selecting this option
enables the automatic start retard and the start retard
slider is displayed. You can set a start retard value
from zero to 10 degrees. The automatic start retard is
active for 10 engine revolutions after engine start while
the engine is running below 450 RPM.
High Speed Data Logging - selecting this option
enables high speed data logging at 100
samples/second. If high speed data logging is not
enabled, the default data logging rate is 10
samples/second.

The CD-1 and similar competitive products
require a trigger signal (magnetic pickup or 12V
module output) with a single pulse per firing event. The
rising edge of the trigger pulse is the most advanced
timing (earliest spark firing) that the unit can generate.
All timing curves and other timing functions are based
on delaying the spark firing referenced to the trigger
pulse. Refer to page 20 for additional information on
trigger timing.
Set the Trig (Trigger) Timing slider value to
correspond to the actual advanced timing point
(degrees BTDC) of your trigger signal. The trigger
timing value represents the most advanced timing that
the CD-1 can generate. The default value is 30
degrees BTDC, but you must enter the actual value for
your engine (or adjust your trigger system so that it
generates a trigger signal at 30 degrees BTDC).
Timing table data “tracks” the trigger timing
value. The table values always represent the actual
engine timing that will result if the trigger system
generates a pulse corresponding to the trigger timing
value.

Cranking Pulses - the slider sets the number of trigger
pulses (events) before the CD-1 fires the first spark.
For a V8 engine, there are 4 trigger pulses per
revolution. To prevent spurious firing when the ignition
key is turned on, you should always use a value of 2 or
higher.
Retard Comp - the slider allows fine tuning the timing
to eliminate the effects of spark firing delay and the
intrinsic delay of some magnetic pickup systems. A
typical value is 1.5 degrees. Check the timing with a
timing light. If a noticeable retard is observed between
2,000 RPM and the upper RPM range of the engine,
use a higher value for retard compensation.

Timing Table Options
Disable Timing Table - no timing table is active.
2D Timing Table - enables a 2D timing table with
timing based on engine RPM.
3D Timing Table - enables a 3D timing table with
timing based on engine RPM and manifold absolute
pressure (MAP). The MAP sensor option box appears.
You can select a 1 bar, 2 bar, or 3 bar MAP sensor. To
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IDLE STABILIZATION AND
GENERAL PURPOSE
INPUT/OUTPUT PARAMETERS
Idle stabilization and general purpose
input/output (GPIO) parameters are displayed in a
dialog box by using the Edit Idle Stabilization and
GPIO Parameters command on the Edit menu. Idle
stabilization is useful for some applications where the
engine tends to stall when put into gear. GPIO
parameters control the function of the GPIO2 terminal
on the CD-1 unit. Note that for the CD-1 Marine

Ignition, the GPI1 and GPIO3 terminals are currently
used for data logging only.
When PC Link CD Marine is first started, default
idle stabilization and GPIO parameters are loaded. The
parameters are updated whenever you download data
from a CD-1 unit or open a setup file. These
parameters are saved along with the module
parameters and timing table data when you save a
setup file. Always check the idle stabilization and
GPIO parameters before uploading data to the
CD-1.

Figure 13 – Idle Stabilization and GPIO Parameters

Idle Stabilization

General Purpose Input/Output 2 (GPIO2)

When enabled, the idle stabilization feature
becomes active after the selected number of trigger
pulses after engine start.

GPIO2 is on the Deustch connector pin 4.
When configured as an output, GPIO2 can switch a 2
amp load to ground. A relay must be used to control
larger loads, such as solenoid valves. GPIO2 has five
modes:

The idle stabilization feature advances ignition
timing below the minimum idle RPM. When engine
speed drops below the minimum idle RPM, the idle
stabilization advance value is added to the normal
advance table value. This increases engine output and
RPM.
Note that idle stabilization can only function
when a timing curve (timing curve switch settings
1-7, but not zero for fixed timing) or PC Link
programmed 2D or 3D timing table is active. Since
trigger timing represents the most advanced timing
the CD-1 can generate, the idle stabilization
advance added to the applicable timing advance at
idle cannot exceed the trigger timing value.

Data Log Only - the system will log data on GPIO2.
You can log a digital signal with zero and +12V levels.
RPM Window Switch - the GPIO2 output will be active
(switched to ground) whenever engine RPM is within
the minimum and maximum values.
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CREATING A NEW TIMING TABLE

Figure 15 – New 3D Timing Table Dialog

If you are creating a new setup file, you must
first select the 2D or 3D timing table option under
module parameters as explained in the Module
Parameters section. You can then use the New Timing
Table command on the File menu. A dialog box
appears as shown in Figure 14 or 15 depending on the
type of timing table you selected.

Figure 14 – New 2D Timing Table Dialog

New 3D Timing Table

New 2D Timing Table
For a new 2D timing table, you can enter the
trigger timing, start and final RPM, and start and final
advance. A new value of trigger timing overrides and
updates whatever value you may have previously
entered under module parameters. Set the trigger
timing value to correspond to the actual advanced
timing point (degrees BTDC) of your trigger signal. The
trigger timing value represents the most advanced
timing that the CD-1 can generate. The default value is
30 degrees BTDC, but you must enter the actual value
for your engine (or adjust your trigger system so that it
generates a trigger signal at 30 degrees BTDC).
Trigger timing is shown on the graph as a straight blue
line. The actual timing advance curve is shown in red.
Since trigger timing represents the most advanced
timing, the red timing curve can never go above the
blue trigger timing line. The total timing range of the
CD-1 is limited to 22 degrees to prevent possible
crossfiring into the next cylinder. For example, if you
set trigger timing to 30 degrees, the actual advance
range is 8.0 to 30 degrees. The program will not allow
you to enter values outside this range.

For a new 3D timing table, you can enter the
trigger timing and a base timing value. The base timing
value is used to generate a flat timing table. A new
value of trigger timing overrides and updates whatever
value you may have previously entered under module
parameters. Set the trigger timing slider to correspond
to the actual advanced timing point (degrees BTDC) of
your trigger signal. The trigger timing value represents
the most advanced timing that the CD-1 can generate.
The default value is 30 degrees BTDC, but you must
enter the actual value for your engine (or adjust your
trigger system so that it generates a trigger signal at 30
degrees BTDC). Since trigger timing represents the
most advanced timing, the 3D timing table values can
never exceed the trigger timing. The total timing range
of the CD-1 is limited to 22 degrees to prevent possible
crossfiring into the next cylinder. For example, if you
set trigger timing to 30 degrees, the actual advance
range is 8.0 to 30 degrees. The program will not allow
you to enter values outside this range.
Each time you click on Update, the
corresponding timing advance table is displayed. You
will find the New Timing Table command useful for
generating a timing advance table that will serve as a
starting point for further edits. When you are ready to
proceed with editing, click on OK.

Each time you click on Update, the
corresponding timing advance table is displayed. You
will find the New Timing Table command useful for
generating a timing advance table that will serve as a
starting point for further edits. When you are ready to
proceed with editing, click on OK.
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EDITING TIMING TABLE DATA
Once you have timing advance table data, you
can edit the data by clicking on and dragging individual
points on the chart display or you can directly edit
numeric data on the spreadsheet grid.

2D Timing Table
The table consists of 21 columns corresponding
to 500 RPM increments from zero to 10,000 RPM. The
10,000 RPM timing value is used at all higher RPM
levels.
The trigger timing value represents the most
advanced timing that the CD-1 can generate. The
default value is 30 degrees BTDC, but you must use
the actual value for your engine (or adjust your trigger
system so that it generates a trigger signal at 30
degrees BTDC). If you need to change the trigger
timing value, go back to module parameters. Trigger

timing is shown on the graph as a straight blue line.
The actual timing advance curve is shown in red. Since
trigger timing represents the most advanced timing, the
red timing curve can never go above the blue trigger
timing line. The total timing range of the CD-1 is limited
to 22 degrees to prevent possible crossfiring into the
next cylinder. For example, if you set trigger timing to
30 degrees, the actual advance range is 8.0 to 30
degrees. The program will not allow you to enter
values outside this range.
There is a slight signal delay within the CD-1
unit. This affects the maximum advance that can be
generated at high RPM. You should leave about 1
degree headroom between the maximum advance
value on your table and the reference (trigger) timing
value. For example, if your reference timing is 30
degrees, you should not use timing table values
exceeding 29 degrees above 3,000 RPM.

Figure 16 – 2D Timing Table

PC Link CD Marine is intended to be an open
system and uses the Component One Chart 7.0 2D
charting control. The adventurous user can experiment
with the chart property pages by right clicking on the
chart. Almost any chart property can be changed. Click
on the Help button for more information. If you corrupt
the chart, exit and restart PC Link CD.
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3D Timing Table
The 3D timing advance table consists of 21
columns corresponding to 500 RPM increments from
zero to 10,000 RPM and 8 manifold pressure (MAP)
rows. The MAP range depends on the type of MAP
sensor selected under module parameters. The timing
value at 10,000 RPM is used at all higher RPM levels
and the timing value in the lowest MAP row is used at
all lower MAP levels. Note that 30 In-Hg corresponds
to atmospheric pressure (zero boost). Normally
aspirated engines will not exceed 30 In-Hg and not all
supercharged engines will reach the maximum MAP
level for 2 bar or 3 bar MAP sensors. You can use the
CD Log software to check the actual MAP values when
the engine is running under various load and throttle
settings.
The trigger timing value represents the most
advanced timing that the CD-1 can generate. The
default value is 30 degrees BTDC, but you must use

the actual value for your engine (or adjust your trigger
system so that it generates a trigger signal at 30
degrees BTDC). If you need to change the trigger
timing value, go back to module parameters. Since
trigger timing represents the most advanced timing, the
3D timing table values can never go exceed the trigger
timing. The total timing range of the CD-1 is limited to
22 degrees to prevent possible crossfiring into the next
cylinder. For example, if you set trigger timing to 30
degrees, the actual advance range is 8.0 to 30
degrees. The program will not allow you to enter
values outside this range.
There is a slight signal delay within the CD-1
unit. This affects the maximum advance that can be
generated at high RPM. You should leave about 1
degree headroom between the maximum advance
value on your table and the reference (trigger) timing
value. For example, if your reference timing is 30
degrees, you should not use timing table values
exceeding 29 degrees above 3,000 RPM.

Figure 17 – 3D Timing Table
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You can rotate the 3D chart display for a better
view of a particular region by dragging the mouse while
holding both mouse buttons down. PC Link CD Marine
is intended to be an open system and uses the
Component One Chart 7.0 3D charting control. The
adventurous user can experiment with the chart
property pages by right clicking on the chart. Almost
any chart property can be changed. Click on the Help
button for more information. If you corrupt the chart,
exit and restart PC Link CD Marine.

Editing Spreadsheet Table Data
You can edit table data using standard Windows
copy and paste operations by selecting cells and then
clicking the right mouse button to pop-up the edit
menu. You can select cells by dragging the mouse with
the left button down. You can also use the Modify
command on the pop-up menu. When you enter a
value, the presence of optional sign (+ or -) or percent
(%) characters affects the outcome of the Modify
command.

Figure 18 – Modify Command

Upload data by using the Upload To EEPROM
command on the Communications menu. A status
message is displayed when the upload process has
been successfully completed.

TRIGGER TIMING
CONSIDERATIONS
Refer to Figure 20. The trigger timing value set
under module parameters must correspond to the
actual timing point (degrees BTDC) of your trigger
signal. The trigger signal can come from a magnetic
pickup crankshaft position sensor, magnetic distributor
pickup, or 12V module trigger signal from another
system such as an electronic engine control module
(ECM). The trigger timing value represents the most
advanced timing that the CD-1 can generate. The
default value is 30 degrees BTDC, but you must enter
the actual value for your engine (or adjust your trigger
system so that it generates a trigger signal at 30
degrees BTDC). Since trigger timing represents the
most advanced timing, the timing table values can
never exceed the trigger timing. The total timing range
of the CD-1 is limited to 22 degrees to prevent possible
cross firing into the next cylinder. For example, if you
set trigger timing to 30 degrees, the actual advance
range is 8.0 to 30 degrees (shaded area in Figure 20).
The trigger timing value is also used by the CD
Log data logging software to allow correct display of
timing advance.

Figure 20 – Trigger Timing
Data Export and Import by Means of Copy
and Paste

TRIGGER TIMING

You might want to export or import table data to
or from another application such as Microsoft Excel
and other programs with tables that support copy and
paste operations. You can directly copy and paste data
to and from the PC Link CD Marine program. In the PC
Link CD Marine program, you can select a range of
cells with the mouse and right click to bring up a copy
and paste menu. When you paste data into the PC
Link CD Marine program, the data is automatically
checked and any out-of-range data corrected.

UPLOADING DATA TO EEPROM

SPARK FIRING

TDC

22°
RANGE
CRANKSHAFT
ROTATION

BDC

Refer to the Downloading Data from EEPROM
section on page 14 for details about USB interface
cable hookup and COM port setup. Before uploading,
make sure the parameters and timing tables are
correct.
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Magnetic Pickup Crankshaft Position
(CKP) Sensor
You can accurately establish the position of the
CKP sensor by temporarily disabling multi-spark and
any timing table in module parameters (remember to
upload to CD-1). Use a timing light to check the timing
and adjust the position of the CKP sensor as required
so that your observed engine timing is the same as the
trigger timing value. For best accuracy, we suggest
that you set the timing at 1,500-2,000 RPM. While you
are conducting this test, you should also check the
distributor phasing. Use a spare distributor cap and drill
or mill a large hole on the top or side so that you can
observe the rotor tip position at cylinder 1 with the
timing light. If you are using a dial-back timing light, set
the dial-back to zero while observing rotor tip position.
The leading edge of the rotor should just touch the cap
terminal.

Magnetic or Mercury Hall Effect Pickup
Distributor without Advance Mechanism
You can accurately establish the position of the
distributor by temporarily disabling multi-spark and any
timing table in module parameters (remember to

upload to CD-1). Use a timing light to check the timing
and adjust the position of the distributor as required so
that your observed engine timing is the same as the
trigger timing value. For best accuracy, we suggest
that you set the timing at 1,500-2,000 RPM.
Mercury Hall effect distributors will require our
P/N 103004 marine rotor or modification of the existing
rotor using the template in the Appendix for proper
phasing.

Magnetic Pickup Distributor with Advance
Mechanism
In this case, you will not be using a timing table,
but you might still want to use the retard features and
data logging. Set the trigger timing value to correspond
to the maximum distributor advance at high RPM.

Module Trigger from an ECM
In this case, you will not be using a timing table,
but you might still want to use the retard features and
data logging. Set the trigger timing value to correspond
to the maximum advance generated by the ECM at
high RPM.
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CD LOG SOFTWARE
The CD Log software supports both marine and
automotive ignitions. When used with the CD-1 Marine,
certain selections, such as vehicle speed, are either
grayed out or not applicable.
The brown tachometer wire (Deutsch connector
pin 11) from the CD-1 is used connect to the USB
interface. Mating single pin Packard Weather Pack
connectors are supplied with the CD-1 to facilitate
disconnecting the brown wire from the tachometer and
connecting it to the USB interface as shown in Figures
1 and 2. PC communications is possible when the
ignition is turned on and the engine has not yet been
started. Once the engine is started, the brown wire
resumes its normal function of driving the tachometer.
Note that no damage occurs if the engine is
inadvertently started while the USB interface is
connected.
When launched for the first time, the program
uses COM1 as the default port. In most cases, you will
have configured the USB interface to use a different
COM port, such as COM5. Use the Port Setup
command on the Communications menu to select the
correct COM port. The program will remember the new
port setup.
After CD Log is launched, the screen initially
appears blank. You can use the Units Selection
command from the Edit menu to pressure units if your
CD-1 is configured to log this data, i.e. a manifold
absolute pressure (MAP) sensor connected. The
program will remember your selections. You can
display data logged by the unit on a chart recorder type
screen. Data logged by the unit must be downloaded
before it can be displayed, by using the Download Data
command on the Communications menu. Once data
has been downloaded, it is automatically displayed on
a chart recorder type screen. You can save the data by
using the Save File command from the File menu after
closing the chart display (data is not lost by closing the
chart display). You can display a previously saved data
file by first using the Open File command on the File
menu and then using the View Chart command on the
View menu.
A sample data file (CD1_Sample.log) is included
in the program folder. Note that this data is from an
automotive drag race session, but is useful for
illustrating the capabilities of the software.

UNITS SELECTION
You can use the Units Selection command from
the Edit menu to select pressure units if your CD-1 is

configured to log this data, i.e. a manifold absolute
pressure (MAP) sensor connected. Note that the speed
units selection is not applicable to marine ignitions. The
program will remember your selections. When you
save downloaded data to a file, the units settings are
saved along with the data. If you later open the file, the
same units settings will remain in effect.

Figure 21 – Units Selection Dialog Box

DOWNLOADING DATA
Connect the USB interface. An adapter harness
is supplied with the USB interface. Connect the
alligator clip on the black wire to ground and the
Packard Weather Pack connector to the brown tach
wire from the CD-1 wire harness. If the tach wire is not
equipped with a Weather Pack connector, you can use
the supplied brown jumper wire with an alligator clip to
make the required connection. Set the switch on the
USB interface to the "A" position. Turn the ignition
switch on to provide power to the CD-1. Do not start
the engine.
When launched for the first time, the program
uses COM1 as the default port. In most cases, you will
have configured the USB interface to use a different
COM port, such as COM5. Use the Port Setup
command on the Communications menu to select the
correct COM port. The program will remember the new
port setup.
Download data by using the Download Data
command on the Communications menu.

DATA LOGGING CHART DISPLAY
You can display data logged by the unit on a
chart recorder type screen. Data logged by the unit
must be downloaded before it can be displayed, by
using the Download Data command on the
Communications menu. Once data has been
downloaded, it is automatically displayed. The last
data logged will appear at the right end of the
chart. You can save the data by using the Save File
command from the File menu. You can display a
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previously saved data file by first using the Open File
command on the File menu and then using the View
Chart command on the View menu.
The data logging memory within the CD-1 stores
the last 18000 data points at 10 samples/second
(default sample rate) or 100 samples/second (if the
high speed data logging mode is selected by means of
the PC Link CD Marine software). This corresponds to
5 hours of data at 10 samples/second or 30 minutes of
data at 100 samples/sec. When you use the Download
Data command on the Communications menu, one of
the popup menus shown below will appear based on
the sampling rate you have configured. You can select
the length of the data set that will be downloaded.

Figure 22 – Download Options Dialog Box
(CD-1 Configured for 10 Samples/Second)

The X axis is always elapsed time. You can zoom in,
zoom out, or zoom all (displays entire data file). At the
maximum zoom in level, approximately 100 data
samples will be displayed on the chart. You can use
the scroll bar to move the chart display window in
terms of elapsed time. If you hold the left mouse button
down within the chart area, a cursor line appears. The
exact values of the parameters displayed on trace 1
and trace 2 and the elapsed time appear in windows
above the chart. When you zoom in or zoom out, the
displayed data will always be centered about the
cursor line. This allows you to quickly select and
closely examine an area of interest. If you want to
analyze the elapsed time between two events (for
example the time required to accelerate from 0 to 60
MPH), you can move the cursor to the first event and
then click on the Reset Time Display button. You can
print the displayed chart to any Windows printer by
clicking on the Print button (a color inkjet printer is
recommended for best results). Data parameters
include:
RPM – engine crankshaft RPM
TIMING – ignition advance in degrees BTDC

Figure 23 – Download Options Dialog Box
(CD-1 Configured for 100 Samples/Second)

MAP – manifold pressure in In-Hg, kilopascals (kPa),
or psi (29.92 In-Hg, 101.3 kPa, or 14.696 psi
corresponds to sea level atmospheric pressure). If a
MAP sensor is not connected, the MAP value
corresponding to zero sensor volts will be displayed.
The CD-1 supports standard Delphi 1 bar, 2 bar, and 3
bar MAP sensor as configured with the PC Link CD
Marine software.
BAT – battery voltage
GPI1 ANALOG – zero to +5V analog input voltage on
the GPI1 input (Deutsch connector pin 3)
RETARD IN – input level on Deutsch connector pin 2
displayed as a digital (on/off) signal
GPI1 DIGITAL – input level on the GPI1 terminal
displayed as a digital (on/off) signal. On means that the
GPIO is terminal is at +12V

Note that CD-1 data files use a .log extension.
You should create a separate folder to store these
files. A sample data file (Sample.log) is included in the
program folder. You have a range of capabilities for
analyzing downloaded data displayed in the chart
recorder format.
You can select two parameters for display.
Trace 1 is displayed in red with its Y axis legends on
the left side of the chart. Trace 2 is displayed in green
with its Y axis legends on the right side of the chart.

GPIO2, GPIO3 – the GPIO2 terminal on Deutsch
connector pin 4 can be configured for various functions
with the PC Link CD Marine software. When configured
as an input, the level is displayed as a digital (on/off)
signal. On means that the GPIO terminal is at +12V.
When configured as output, the status is also displayed
as a digital (on/off) signal. On means that the GPIO
terminal is switched to ground. This is referred to as an
active low output. GPIO3 is always an input. On means
that the GPIO3 is terminal is at +12V
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The maximum RPM value displayed on the chart
can be set by means of a command on the Chart
Display Edit Menu. Caution: If the maximum value is
set lower than the actual logged data, the chart
cursor function will not update the display
correctly.
Additional data is displayed at the lower right
side of the screen. This data includes:
Status - displays CD-1 status

Diagnostic Code – normally blank unless a diagnostic
code is set.
Log Interval – the actual data logging interval in
seconds
You can clear the data within the unit by using
the Clear CD-1 Data Buffer command from the
Communications menu. If you change the data logging
mode with the PC Link CD Marine software, you
should also clear the data buffer within the unit.

Figure 24 – Data Logging Chart Display

IMPORTING DATA INTO EXCEL
Data files saved from CD Log are in comma
delimited ASCII format. Note that VSS data is scaled in
MPH units and MAP data is scaled in In-Hg units. You
can easily import a data file into other programs such
as Microsoft Excel for further analysis. You can also
view data files with a text editor such as Windows
WordPad. To import a data file into Excel:

1. Start Excel. In the File Open dialog box, select
Files of type: All Files (*.*). Then browse for the
data file.
2. The Text Import Wizard appears. For step 1, select
delimited file type. For step 2, select comma
delimiter. For step 3, select general column data
format. Then click on Finish.
3. You can then format the data and save the
spreadsheet as an Excel file.

Daytona Sensors LLC, 933 Beville Road, Suite 101-I, S. Daytona, FL 32119
(386) 322-7390 www.daytona-sensors.com
Page 24

CD-1 Marine
5/2015

APPENDIX – TIMING CURVES
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TEMPLATE FOR MERCURY MARINE ROTOR MODIFICATION
152°

DRILL 4 NEW HOLES 30° CLOCKWISE
FROM ORIGINAL HOLES (SHOWN BY
DOTTED OUTLINES)

ORIGINAL HOLES
30°

TOP

TOP
Ø0.141
3 PLACES
32°

R0.440
3 PLACES

R0.385
32°

Ø0.172

88°

Download the instruction sheet from our website. Print the template on velum
or tracing paper. Apply a small amount of glue from a glue stick. Overlay
template on rotor and align with existing holes. Then center punch new holes.
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APPENDIX – RECOMMENDED
PARTS AND SUPPLIERS
MAP SENSORS
To connect a Delphi MAP sensor for boost
timing retard mode or for implementing a 3D timing
table, you will have to fabricate a wiring harness with
the appropriate mating connector or use our MAP
sensor harness kit P/N 102006. Recommended Delphi
MAP sensors, and equivalent aftermarket parts are
listed in the table below. Note that Wells is stocked by
Autozone (www.autozone.com) and SMP (Standard
Motor Products) is stocked by RockAuto
(www.rockauto.com).
Range

Delphi P/N

1 bar
(normally
aspirated
engines)

12219927,
16254719,
16175339,
12247561

2 bar (0-15
psi boost)

16009886

3 bar (0-30
psi boost)

12223861

Aftermarket P/Ns
Wells SU105
SMP AS165
Wells SU129
SMP AS4
Wells SU504
SMP AS210

CRIMP TERMINALS
High quality crimp terminals and a proper
crimping tool are required to make reliable electrical
connections. Crimp terminals commonly sold in
automotive and hardware stores have brittle vinyl
insulation that easily cracks. For marine applications,
we recommend Molex Perma-Seal nylon insulated
crimp terminals with hot-melt adhesive lined sleeves.
The following parts are available from Mouser.
P/N
19164-0003
19164-0004
19164-0005
19164-0026
19164-0027
19164-0066
19164-0067
19164-0017
19164-0050
19164-0013
19164-0044
19164-0056

Description
18-22 AWG #10 ring tongue terminal
18-22 AWG 1/4” ring tongue terminal
18-22 AWG 3/8” ring tongue terminal
14-16 AWG 1/4” ring tongue terminal
14-16 AWG 5/16” ring tongue terminal
10-12 AWG 1/4” ring tongue terminal
10-12 AWG 5/16” ring tongue terminal
18-22 AWG 1/4” female quick
disconnect terminal
14-16 AWG 1/4” female quick
disconnect terminal
18-22 AWG butt splice
14-16 AWG butt splice
10-12 AWG butt splice

RELAYS
WIRE
Corrosion is the number one enemy of marine
electrical systems. Do not use un-tinned copper wire.
The unprotected copper in this inexpensive wire
quickly oxidizes, especially when in contact with
dissimilar metals on terminals. We recommend the use
of high quality industrial grade wire with tinned copper
strands and a high strand count.
18-20 AWG sizes can be used for all signal and
low current applications. Carol UL grade 1007/1015
wire is available from Digi-Key.
P/N
Description
C2040X-100
20 AWG wire (100 foot spool)
C2064X-100
18 AWG wire (100 foot spool)
C2104X-100
16 AWG wire (100 foot spool)
C2105X-100
14 AWG wire (100 foot spool)
Note: replace X with color code B=Black,
W=White, R=Red, G=Green, A=Orange,
Y=Yellow, L=Blue, N=Brown, S=Gray,
V=Violet

The typical import brand 30-40 amp relays leave
little safety margin. When used to switch heavy
inductive solenoid loads, arcing can result in the
contacts welding together – a potentially catastrophic
failure mode. We recommend using Tyco/P&B
automotive OE grade relays available from Newark
Electronics and Digi-Key. Use the 40 amp version for
most applications and the 70 amp version for heavy
duty applications. We recommend that you use the
relay sockets and crimp terminals listed along with the
relays.
P/N
1432791-1
VCF4-1001
60249-1
VF7-41F11
VCF7-1000
42281-1
280756-4
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Description
40 amp VF4 series relay
Socket for VF4 series relay
12-16 AWG terminal for VF4
70 amp VF7 series relay
Socket for VF7 series relay
14-18 AWG terminal for VF4 coil
connections (2 required)
10-14 AWG terminal for VF7
contact connections (2 required)
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FUSES AND FUSE TAPS

SUPPLIERS

ATC series fuses and fuse holders commonly
used for automotive applications are only available in
40 amp and lower ratings. For high current
applications, we recommend the heavy duty 50 amp
Littlefuse Maxi Fuse series available from Digi-Key.

Suppliers referenced in the Appendix are listed
in the table below. Additional suppliers for connectors,
electronic tools, mechanical hardware, and test
equipment are listed on our website at
www.daytona-sensors.com/tech_tools.htm.

P/N
F1085
F1038

Description
Maxi fuse block
50 amp Maxi fuse

SWITCHES
All switches used in marine performance
applications should be sealed. Representative sealed
toggle and rocker style switches available from DigiKey are listed below.
P/N
480-2191
360-2278

Supplier

Phone

Website

Digi-Key

1-800-344-4539

www.digi-key.com

Mouser

1-800-346-6873

www.mouser.com

Newark

1-800-463-9275

www.newarkinone.com

State Wire
& Terminal

1-800-922-6527

www.statewire.com

Description
Honeywell SPDT toggle switch
NKK SPDT rocker switch

RELIABLE CONNECTIONS TO EXISTING
SIGNALS
For some applications, you may have to tap into
existing signal wires. We caution against using any of
the so called “vampire clips” that make an insulation
displacement connection. These have proven very
unreliable in racing applications. They may even cause
the original wire to fray and break. We suggest
soldering any connections to existing signals. Use a
stripping tool to cut through and push back about 1/4”
of insulation at the spot on the original wire where you
plan to make the connection. Wrap several turns of the
new wire around, solder, insulate with self vulcanizing
electrical tape, and use two cable ties to secure the
splice as shown. Regular electrical tape will tend to
unravel. Self vulcanizing electrical tape is available
from Digi-Key as their P/N W213.
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